LIFE AND PHYSICAL SCIENCES
Student Learning Outcome Alignment Form

Course Prefix/Number: BIOL 1306

Course Title: Biology for Science Majors |

Core Objective

Course SLO

General Learning Activities

Assessment

Critical Thinking Skills

(SLO #10) Apply scientific reasoning
to investigate questions and utilize
scientific tools such as microscopes
and laboratory equipment to collect
and analyze data.

Enzyme lab where rates of catalase activity are
investigated. Temperature, ph, concentration of
substrate are examined. See attached activity.

Grade, included
rubric. See
attached rubric.

Communication Skills

(SLO# 4). Compare and contrast the
structures, reproduction, and
characteristics of viruses, prokaryotic
cells, and eukaryotic cells

As essay question on the test, the student draws or
describes the process of meiosis for a diploid
organism for even numbers 2-10 (including
interphase). See attached activity.

Test essay
question,
included rubric.
See attached
rubric

Empirical & Quantitative

(SLO #7)Identify the principles of

Student works Mendelian genetics problems. See

Test questions,

cell membranes and the movement
of molecules across a

membrane.

conductivity probes to track ions across membranes
into sucrose or water solutions. The students
determine rates of diffusion with different
concentration gradients, compare with sucrose and
water solutions. See attached activity.

Skills inheritance and solve classical attached activity. included rubric.
genetic problems. See attached
rubric
Teamwork (SLO #17) Describe the structure of Students work in groups of four, using electrical Grade and

included rubric.
See attached
rubric
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CRITICAL THINKING VALUE RUBRIC
Adapted for Texarkana College from the AAC&U Ciritical Thinking VALUE Rubric

Definition
Critical thinking is a habit of mind characterized by the comprehensive exploration of issues, ideas, artifacts, and events before accepting or formulating an opinion or conclusion.

Does Not Meet Any
Expectations

1

Meets Few
Expectations

2

Meets Expectations

Exceeds Some
Expectations

4

Exceeds All
Expectations

5

Explanation of Issues

Did not state issue.

Issue is stated without
clarification or description.

Issue is stated but
description leaves some
terms undefined,
ambiguities unexplored,
boundaries undetermined
and/or backgrounds
unknown.

Issue is stated, described,
and clarified so that
understanding is not
seriously impeded by
omissions.

Issue is stated clearly and
described comprehensively,
delivering all relevant
information necessary for
full understanding.

Evidence

Does not identify the basic
components of an issue

Information is taken from
sources without any
interpretation. Viewpoints
of experts are taken as fact,
without question

Information is taken from
sources with some
interpretation but not
enough to develop a
coherent analysis or
synthesis.

Information is taken from
sources with enough
interpretation to develop a
coherent analysis or
synthesis.

Information is taken from
sources with enough
interpretation to develop a
comprehensive analysis or
synthesis.

Influence of Context and
Assumptions

Did not show awareness of
the issue.

Show an emerging
awareness of present
assumptions.

Questions some
assumptions. Identifies
relevant information when
presenting a position.

Identifies own and others’
assumptions and several
relevant contexts when
presenting a position.

Thoroughly analyzes own
and others’ assumptions and
carefully evaluates the
relevance of contexts when
presenting a position.

Student’s Position

Takes no position on issue

Specific position is stated

but is simplistic and obvious.

Specific position
acknowledges different
sides of an issue.

Specific position takes into
account the complexities of
an issue. Others’ points of
view are acknowledged
within position.

Specific position is
imaginative. Limits of
position acknowledged.
Other points of view are
synthesized.




Conclusions and Related
Outcomes

Does not use previously
learned information in new
situations.

Conclusion is inconsistently
tied to some of the
information discussed;
related outcomes are
oversimplified.

Conclusion is logically tied to
information; some related
outcomes are identified.

Conclusion is logically tied to
a rage of information,
including opposing
viewpoints; related
outcomes are identified
clearly

Conclusions and related
outcomes are logical and
reflect student’s informed
evaluation and ability to
place evidence and
perspectives discussed in
priority order




Communication RUBRIC

Definition

Written communication is the development and expression of ideas in writing.

Oral Communication is a prepared, purposeful presentation designed to increase knowledge, to foster understanding, or to promote change in the listeners’ attitudes, values, beliefs, or behaviors.
Visual Communication is the use of images to persuade, entertain, inform, and enlighten an observing audience of products, ideas, and messages.

Adapted for Texarkana College from the AAC&U Ciritical Thinking VALUE Rubric and Making Learning Real

Does Not Meet Any
Expectations

1

Meets Few
Expectations

2

Meets Expectations

Exceeds Some
Expectations

4

Exceeds All
Expectations

5

Quality of Information and
Organization

Presentation lacks main
points and related details.
Information lacks
connection to the
presentation topic.
Information is not
organized.

Main points are not clear
and lack significant detail.
Some information is linked
to the presentation topic.
Information is loosely
organized.

Main points are somewhat
clear but could use more
detail. Most information is
linked to the presentation
topic. Information is
organized.

Main points are clear and
detailed. Information is

linked to presentation topic.

Information is well
organized.

Main points are very clear
and very detailed.
Information is directly linked
to presentation topic.
Information is very
organized.

Nonverbal Communication

Speaker appears very
uneasy and insecure.
Speaker faces away from
the audience or makes no
eye contact. Speaker
appears disengaged from
the audience. Speaker uses
few body motions or
gestures or has gestures or
movements that distract the
audience.

Speaker appears uneasy and
somewhat insecure.
Speaker rarely faces the
audience or makes eye
contact. Speaker rarely
appears to be engaging with
the audience. Speaker uses
few body motions or has
gestures or movements that
distract the audience..

Speaker appears generally
at ease and confident.
Speaker sometimes faces
the audience and maintains
eye contact. Speaker
sometimes appears to be
engaging with the audience.
Speaker’s body motions and
gestures neither support
nor detract from
presentation.

Speaker appears fairly
comfortable and confident.
Speaker generally faces the
audience and maintains
good eye contact. Speaker
generally appears to be

engaging with the audience.

Speaker uses body motions
and gestures well.

Speaker appears very
comfortable and confident.
Speaker consistently faces
the audience and maintains
good eye contact. Speaker
consistently appears to be
engaging with the audience.
Speaker uses body motions
and gestures very
effectively.

Quality of Verbal
Communication

Speaker’s voice is
consistently too weak or too
strong. Speaker fails to use
inflections to emphasize key
points and create interest or
often uses inflections

Speaker’s voice is frequently
too weak or too strong.
Speaker rarely uses
inflections to emphasize key
points and create interest or
speaker sometimes uses

Speaker’s voice is generally
steady strong and clear.
Speaker sometimes uses
inflections to emphasize key
points and create interest.

Speaker’s voice is steady,
strong, and clear. Speaker
often uses inflections to
emphasize key points and
create interest. Speaker’s

Speaker’s voice is very
confident, steady, strong,
and clear. Speaker
consistently uses inflections
to emphasize key points or
to create interest. Speaker’s




inappropriately. Speaker’s
talking paces is consistently
too slow or too fast.

inflections inappropriately.
Speaker’s talking pace is
often too slow or too fast.

Speaker’s talking pace is
appropriate.

talking pace is mostly
appropriate.

talking pace is consistently
appropriate.

Visual Tools

Visual aids demonstrate no
creativity or clarity and are
often difficult to read.
Presentation is weakened
by the visual tools.

Visual aids have limited
creativity or clarity or are
sometimes difficult to read.
Presentation is not
enhanced by the visual
tools.

Visual aids are reasonably
creative, clear, and easy to
read. Presentation is
sometimes enhanced by the
visual tools.

Visual aids are usually
creative, clear, and easy to
read. Presentation is often
enhanced by the visual
tools.

Visual aids are very creative,
clear, and easy to read.
Presentation is consistently
enhanced by the visual
tools.

Appropriate Use of
Vocabulary

Few or no terms are
included in the
presentation. May or may
not be used appropriately.
Lacks context.

Several terms are included
in the presentation. May or
may not be used
appropriately. May lack
context.

Most terms are included in
the presentation. Generally
used appropriately.
Generally used in
appropriate context.

All terms are included in the
presentation. Used
effectively. Used in context.

All terms are included in the
presentation. Used in
unique and creative ways.
Used in context

Precision and Detail in
Documents Produced

Written documents have
numerous errors and lack
detail. Little carte taken in
the production.

Documents may have some
errors and show some
detail. Some care has been
taken in production.

Evident that written
documents are correct and
show a general attention to
detail and accuracy. General
care has been taken in
production.

Clearly evident that written
documents are correct,
detailed and accurate. Care
has been taken in
production.

Documents are clear, well-
constructed, accurate, and
show attention to detail.
Extra care has been taken in
the production of written
documents.

Overall Presentational
Effectiveness

The presentation was weak
and not effective.

The presentation was
average and somewhat
effective.

The presentation was good
and effective.

The presentation was very
good and effective.

The presentation was
exceptional and extremely
effective.




Empirical and Quantitative Skills RUBRIC
Adapted for Texarkana College from the AAC&U Ciritical Thinking VALUE Rubric

Definition
The ability to formulate an inquiry that is scientific or mathematical in nature, and then manipulate and analyze numerical data and/or follow an investigative process using
empirical and/or quantitative reasoning to satisfy the inquiry and create informed conclusions.

Does Not Meet Any
Expectations

1

Meets Few
Expectations

2

Meets Expectations

3

Exceeds Some
Expectations

4

Exceeds All
Expectations

5

Identification

The purpose,
components, and
variables of the
investigation/project are
not identified.

The purpose,
components, and
variables of the
investigation/project are
somewhat identified.

The purpose,
components, and
variables of the
investigation/project are
mostly identified

The purpose,
components, and
variables of the
investigation/project are
clearly identified..

The purpose,
components, and
variables of the
investigation/project are
clearly identified.

Assimilation

The information that is
required for an analysis of
all investigative
components is not
evident. If applicable,
values are incorrectly
translated into variables
and no necessary
formulas are present.

The information that is
required for an analysis of
all investigative
components is somewhat
evident. If applicable,
values are incorrectly
translated into variables
and some necessary
formulas are present.

The information that is
required for an analysis of
all investigative
components is mostly
evident. If applicable,
some values are correctly
translated into variables
and most necessary
formulas are present.

The information that is
required for an analysis of
all investigative
components is evident. If
applicable, most values
are correctly translated
into variables and all
necessary formulas are
present.

The information that is
required for an analysis of
all investigative
components is clearly
evident. If applicable,
values are correctly
translated into variables
and all necessary
formulas are present.

Analysis

Most investigative or
quantitative components
are not scrutinized. The
steps followed are illogical
and/or irrelevant to the
desired result. The proper
tools/ technology were not
used and/or integrated

Some investigative or
quantitative components
are scrutinized. Some
steps followed are
somewhat logical and
relevant to the desired
result. The proper tools/
technology were

All investigative or
guantitative components
are somewhat scrutinized.
The steps followed are
mostly logical and
relevant to the desired
result. The proper tools/
technology were mostly

All investigative or
quantitative components
are scrutinized. The steps
followed are logical and
relevant to the desired
result. The proper tools/
technology were used and
mostly integrated into the

All investigative or
guantitative components
are methodically
scrutinized. The steps
followed are logical and
relevant to the desired
result. The proper tools/
technology were used and




into the final product. Any
notation is not consistent
and not defined.

somewhat used and not
integrated into the final
product. Any notation is
somewhat consistent but
not defined.

used and somewhat
integrated into the final
product. Any notation is
mostly consistent and
defined.

final product. Any
notation is consistent and
well defined.

well integrated into the
final product. Any
notation is consistent and
well defined.

Presentation

A summary of the analysis
is either inadequately
presented or not
presented at all. The
presented information is
mostly incorrect, and/or of
poor quality, and/or the
terminology/figures are
inaccurate and/or hard to
understand. Few or no
visual representations of
evidence are acceptably
scaled/ represent the
analysis findings.

A partial summary of the
analysis is presented. The
presented information is
somewhat correct, of
adequate quality, and the
terminology/figures are
somewhat accurate and
relatively easy to
understand. Some visual
representations of
evidence are acceptably
scaled and represent the
analysis findings.

A summary of the analysis
is presented. The
presented information is
mostly correct, of good
quality, and the
terminology/figures are
mostly accurate and easy
to understand. Most visual
representations of
evidence are acceptably
scaled and represent the
analysis findings.

A good summary of the
analysis is presented.
The presented information
is correct, of good quality,
and the
terminology/figures are
accurate and easy to
understand. Most visual
representations of
evidence are well-scaled
and/or well represent the
analysis findings..

A concise summary of the
analysis is presented.
The presented information
is correct, of high quality,
and the
terminology/figures are
accurate and easy to
understand. All visual
representations of
evidence are well-scaled
and well represent the
analysis findings.

Application

The integration does not
include all steps of the
investigation and does not
lead to an accurate, nor
complete conclusion that
relates to the initial
investigative argument.

The integration of most
steps of the investigation
lead to a somewhat
accurate, partially
complete conclusion that
is relative to the initial
investigative statement.

The coherent integration
of most steps of the
investigation lead to an
accurate, mostly
complete, acceptable
conclusion that is relative
to the initial investigative
statement.

The coherent integration
of all steps of the
investigation lead to an
accurate, mostly
complete, relevant
conclusion that is relative
to the initial investigative
statement.

The coherent integration
of all steps of the
investigation lead to an
accurate, complete,
relevant conclusion that is
relative to the initial
investigative statement.




Teamwork Skills RUBRIC
Adapted for Texarkana College from the AAC&U Ciritical Thinking VALUE Rubric

Definition
Teamwork is behaviors under the control of individual team members, their manner of interacting with others on team, and the quantity and quality of contributions they
make to team discussions.

Does Not Meet Any
Expectations

1

Meets Few
Expectations

2

Meets Expectations

Exceeds Some
Expectations

4

Exceeds All
Expectations

5

Contributes to Team
Meetings

Does not collect any
relevant information; no
useful suggestions to
address team's needs;

Shares ideas but does not
advance the work of the

group.

Offers new suggestions to
advance the work of the

group

Offers alternative solutions
or

courses of action that build
on the ideas of others.

Helps the group move
forward by articulating the
merits of alternative ideas
or proposals

Facilitates the
Contributions of Team
Members

Often argues with team
mates; doesn't let anyone
else talk; occasional
personal attacks and "put-
downs"; wants to have
things done his way and
does not listen to alternate
approaches;

Engages group by taking
turns and listening to others

without interrupting.

Engages group by restating
the views of other members
and/or asking questions for

clarification.

Engages group by

constructively building upon
or synthesizing the
contributions of others..

Engages group by both
constructively building upon
and synthesizing the

contributions of others as
well as noticing when
someone is not participating
and inviting him/her to
engage.

Individual Contributions
Outside of Team Meetings

Completes no assigned
tasks outside of team
meetings.

Completes some assigned
tasks by deadline.

Completes all assigned
tasks by deadline; work
accomplished advances
the project.

Completes all assigned
tasks by deadline; work
accomplished and is
thorough, comprehensive,
and advances the project.

Completes all assigned
tasks by deadline; work
accomplished is thorough,
comprehensive, and
advances the project.
Proactively helps other
team members complete
their assigned tasks to a
similar level of excellence.




Fosters Constructive Team
Climate

Is argumentative and
does not work with the
team.

Supports a constructive
group climate by treating

other members respectfully.

Supports a constructive
group climate by treating
other members respectfully
and conveying a positive
attitude about the group
and its work.

Supports a constructive
group climate by treating
other members respectfully,
conveying a positive
attitude about the group
and its work, and motivating
other group members.

Supports a constructive
group climate by treating
other members respectfully,
conveying a positive
attitude about the group
and its work, motivating
other group members, and
providing assistance to
group members.

Responds to Conflict

Is not present enough to
engage in conflict.

Passively accepts alternate
viewpoints/ideas/opinions.

Redirects focus toward
common ground, toward
task at hand (away from
conflict)..

Identifies and acknowledges
conflict and stays engaged
with it.

Addresses conflict directly
and helps to
manage/resolve it in a way
that strengthens overall
group cohesiveness.




Syllabus: Principles of Biology | for Science Majors
Course Number: BIOL 1406
Semester & Year: Fall 2013

Instructor Information

Name: Mark Storey

Office: Chemistry Building Rm. 202
Telephone: 903-823-3298

E-mail: Mark.Storey@texarkanacollege.edu
Office Hours:

Textbook Information

e Principles of Life. Hillis, Sadava, Heller and Price 1%t ed.(2012) Sinauer Assoc Inc and W.H. Freeman and Co. ISBN 978-1-4292-
5721-3 (required)

e Lab Packet — Prof. STOREY (required)

e Protective clothing - Safety glasses will be required for certain lab activities, lab coat or apron (old work shirt) is encouraged.

e Optional Website: (yourBioPortal.com) http://courses.bfwpub.com/hillisle.php

Student Learning Outcomes for the Course

At the conclusion of the lecture portion of this course students should be able to:

Describe the characteristics of life.

Explain the reasoning used by scientists.

Identify the basic properties of substances needed for life.

Compare and contrast the structures, reproduction, and characteristics of viruses, prokaryotic
cells, and eukaryotic cells.
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Describe the structure of cell membranes and the movement of molecules across a membrane.
Identify the substrates, products, and important chemical pathways in metabolism.

Identify the principles of inheritance and solve classical genetic problems.

Identify the chemical structures, synthesis, and regulation of nucleic acids and proteins.
Describe the unity and diversity of life and the evidence for evolution through natural selection.

LN U,

At the conclusion of the laboratory portion of this course students should be able to:

1.

Nou,k~wnN

8.
9.

Be able to apply scientific reasoning to investigate questions, and utilize scientific tools such as
microscopes and laboratory equipment to collect and analyze data.

Use critical thinking and scientific problem-solving to make informed decisions in the laboratory.
Communicate effectively the results of investigations.

Describe the characteristics of life.

Explain the reasoning used by scientists.

Identify the basic properties of substances needed for life.

Compare and contrast the structures, reproduction, and characteristics of viruses, prokaryotic cells,
and eukaryotic cells.

Describe the structure of cell membranes and the movement of molecules across a membrane.
Identify the substrates, products, and important chemical pathways in metabolism.

10. Identify the principles of inheritance and solve classical genetic problems.
11. Identify the chemical structures, synthesis, and regulation of nucleic acids and proteins.
12. Describe the unity and diversity of life and the evidence for evolution through natural selection.

Student Requirements for Completion of the Course

Lecture Topics/ Exams - Biology 1406 Spring 2013

EXAM |

Chapter 1: Principles of Life

Chapter 2: Life Chemistry and Energy

Chapter 3: Nucleic Acids, Proteins and Enzymes

Chapter 4: Cells: The Working Units of Life

EXAM I



Chapter 5: Cell Membranes and Signaling
Chapter 6: Pathways that Harvest and Store Chemical Energy
Chapter 7: The Cell Cycle and Cell Division

Chapter 8: Inheritance, Genes and Chromosomes

EXAM 111

Chapter 9: DNA and Its Role in Heredity

Chapter 10: From DNA to Protein: Gene Expression
Chapter 11: Regulation of Gene Expression

Chapter 12: Genomes

FINAL EXAM (Comprehensive) Emphasis on Student Learning Guide Questions Chapters 1-11 and selected essay questions from Exams |, I, and III.

Student Assessment

Three (3) lecture exams will be given over thee units and a comprehensive final exam, for a total of four exams valued at 55% of the course grade. The
examination format will include multiple choice, short answer and essay items. Exams will be administered a minimum of one (1) week after being
announced. Please inform the instructor ASAP if you know you will miss a lecture exam on the scheduled date and make arrangements to take the exam in
advance. Portions of the lecture unit exams will be conducted in the TC testing center.

Course Testing POLICY - TC Testing Center

Lecture Exams are conducted using the TC CMS (Moodle) and administered in the TC testing Center.

Part 1: Section A 40 multiple guess questions (56 points/100)
This part of the exam consists of 40 multiple guess "choice" questions. (each question is valued @ 1.4 points each) This portion is not timed but must be
completed in one session, and you only have 1 attempt to complete this 40 question session.




You are also required to take Part I: Section B: 10 question Merit based curve portion of the exam (10 questions @ 1.4 points = 14 points) during the same
testing session in the TC testing center. (Failure to complete this portion during the same session will result in a score of zero on Part B of the exam.)

Part Il: Essay/short answer portion of the exam is available by requesting a test booklet from the TC testing center proctor. Write your responses on the

test booklet. No outside paper is allowed on this exam. You are NOT required to take the essays during the same test session as Part | SectionA &
Section B.

EXAM must be completed by before the close of the testing center that evening. (can't start a test after 8PM ... center closes at 8:30PM.)

| understand the course requirement to take the two (2) parts of the remaining lecture exams Part | Section A and Part 1 Section B (Total of 70 points)
during the same testing session (no break allowed) on the Moodle Course Management System (TC Online). | understand that | may take the Part Il Essay
(30 points) during a different testing session. All sections of the exam must be completed prior to the exam deadline. | also understand no outside materials
(paper, study materials) are allowed to be brought in to the testing center.

| understand that there are no makeup exams available for these exams.

The course grade will be calculated from the following schedule:

Lecture Exams (3) & 55%
Final Exam (1)

Online Weekly Quizzes 10%
Lab Exams + Participation Lecture & Lab 20%
Lab Reports 15%

Total 100%




Grading Scale

Semester Grade Course Average
A 90-100
B 80-89
C 70-79
D 60-69
F 59-below

Class Schedule

Chapter 1: Principles of Life
Chapter 2: Life Chemistry and Energy
Chapter 3: Nucleic Acids, Proteins and Enzymes

Chapter 4: Cells: The Working Units of Life

EXAM | (Chapters 1-4) (5'" week)

Chapter 5: Cell Membranes and Signaling
Chapter 6: Pathways that Harvest and Store Chemical Energy
Chapter 7: The Cell Cycle and Cell Division

Chapter 8: Inheritance, Genes and Chromosomes
EXAM Il (Chapters 5-8) (10" week)

Chapter 9: DNA and Its Role in Heredity
Chapter 10: From DNA to Protein: Gene Expression
Chapter 11: Regulation of Gene Expression



Chapter 12: Genomes

EXAM Il (Chapters 9-12) (15" week)

Absentee Policy (TC Official Policy)

Texarkana College’s absentee policy allows instructors to withdraw a student from a course due to excessive absences. If a student
leaves and returns during class or leaves the class before the class is over, he/she may be considered absent. Three tardies constitute
one absence. Check the syllabus for each class to see how much time you are allowed to be late before the tardy is counted as an
absence. (10 minutes after class has begun)

Do no stop attending a class without formally withdrawing from the course by the institution’s published Last Day to Drop. If a
student does not attend class and does not withdraw from the class, the student will receive a grade of F in the class. The published
Last Day to Drop applies to students; an instructor may withdraw a student for excessive absences at any time during the semester.
Withdrawal from a course(s) may affect a student’s current or future financial aid eligibility. Students should consult the Financial
Aid Office to learn both short and long term consequences of a withdrawal.

As an adult learner, you must assume responsibility for attending lecture classes and laboratories. It is to your benefit to be present at each class session.
You should make every effort to be present in each class because: the laboratory class is designed to provide hands-on learning experiences. Students will
learn basic laboratory skills while reinforcing concepts learned in lecture. To a large extent, grades in the laboratory will reflect participation and laboratory
skills acquired, so it is important that students do not miss laboratory exercises.

The maximum number of absences in a MW or T-TR class is four (4) per semester (the equivalent of two (2) weeks of instruction). The only excused
absences are for officially recognized TC student club activities or for Texarkana College official business. Please Note: lliness and doctor appointments do

not qualify as an excused absence.

EXCUSED ABSENCES (TC Official Policy)

A student’s absence due to school trips and/or school business will not be counted against a student’s allowable number of absences. Military duty
and absences for Holy Days (FBD LEGAL) are covered in a separate section of the catalog and the student handbook. These are the only types of
absences that are considered excused by Texarkana College. Responsibility for work missed for any absence is placed on the student. Instructors are
required to allow students to make up work missed if the absence is due to military duty or religious holy days when students follow the correct



notification procedures. Instructors are not required to allow students to make up work for absences due to other reasons. Make-up policies are
listed in each individual instructor’s syllabus.

WARNING: If you exceed the maximum number of absences for this course (lecture and lab are counted together you will be dropped (W) from the
course. For example if you miss a lecture and attend the lab you will be counted absent for that class session (maximum of 4 sessions) (NO EXCEPTIONS).

Students are required to attend lecture and laboratory classes for the entire period. Students that arrive more than 10 minutes after class has begun or
leave early, will be marked as absent. Students that arrive between 1 and 10 minutes after class has begun will be recorded as tardy. Three tardies will be
recorded as an absence. Students that sleep during class, ignore this class because they are busy texting, chatting, checking social media sites or doing
homework for other classes or do not participate in class activities for any other reason, will be marked as absent!

If situations make it necessary for missing class or lab you are still responsible for all the work you missed during class and lab. If you miss class, you should

let me know ASAP (by TC student e-mail) and in advance if at all possible. | can give you the assignments to help you remain current in the course.

If circumstances develop (e.g. extended illness, moving from the city, etc.) which necessitates your withdrawal from this or any other course be sure to let
me know AND officially withdraw in the Director of Admissions office located in the C. M. Nelson Administration building. The date each semester is posted
on the inside page of the current Texarkana College Catalog / Website under "Academic Calendar". A grade of W is recorded on your permanent transcript
if you withdraw before the official deadline.

Make-up Policy

Lecture Exams: The only portions of lecture exams that will be available as a makeup exam (only during final exam week) will those portions of an exam

that were administered during a regular classroom session. All portions of exams that were originally administered over a period of time in the college

testing center cannot be made up. NO EXCEPTIONS will be made to this policy.

IMPORTANT: No class curve (grade adjustment) is applied to make up exams.

Lab Exams: No makeup exams are available for Lab Exams !




Lab Reports and other written assignments in lecture and lab are due at the beginning of the class session (lecture) and will be penalized 10% for being late
for the first 24 hours and 20% for the second 24 hours and will not be accepted after 48 hours . Late work can be turned in via e-mail to my e-mail address:

Mark.Storey@texarkanacollege.edu

Class Conduct

Students are expected to conduct themselves as adults. Any student who acts in such a manner as to disturb the class and interfere with the learning
process will be expelled from the course with a grade of "F". No music players or cellular phones are permitted in my classroom. No texting or talking
during class...TURN THEM OFF! (See Absentee Policy above)

If you bring a cell phone (electronic communication device) into my classroom, be sure that it is turned off and not out on your desk. If | notice you using
your phone during lecture and ask you to turn it off on the first offense the second time you will be asked to leave and you will be counted absent for that
class period. (You will be free to communicate electronically during breaks during each class session.)

Any student that has a cell phone or any electronic communications device in their possession during any quiz or examination will receive a zero (0) for
the quiz or examination. NO EXEPTIONS! You will also be counted absent for that class session.

All electronic devices (e.g. audio recorders, laptop/tablet computers etc.) brought into class must be cleared by the instructor for use for each class session.

Academic Integrity Statement
Scholastic dishonesty, involving but not limited to cheating on a test, plagiarism, collusion, or falsification of records will make the student liable for disciplinary action after being
investigated by the Dean of Students. Proven violations of this nature will result in the student being dropped from the class with an “F”.

This policy applies campus wide, including TC Testing Center, as well as off-campus classroom or lab sites, including dual credit
campuses. This information can be found in the Student Handbook at https://texarkanacollege.edu.

Disability Act Statement:

Texarkana College complies with all provisions of the Americans with Disabilities Act and makes reasonable accommodations upon request. Please
contact Larry Andrews at 903.823.3283, or go by the Recruitment, Advisement, and Retention Department located in the Administration building

for personal assistance.
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If you have an accommodation letter from their office indicating that you have a disability which requires academic accommodations, please
present it to me so we can discuss the accommodations that you might need for this class. It is best to request these changes at the beginning if not

before the start of class so there is ample time to make the accommodations..

Financial Aid:

Attention! Dropping this class may affect your funding in a negative way! You could owe money to the college and/or federal government. Please

check with the Financial Aid office before making a decision.

Course Continuity Plan

In the case that the college officially closes because of an emergency (inclement weather etc.) which causes a short term disruption of
this course, we will use the TC Moodle CMS (“TC Online”) and TC student e-mail to continue this course in the short term (1-3 weeks). All
students need to use their campus e-mail to receive course related information.

I reserve the right to modify the syllabus at any time during the semester. The online version of
this syllabus (TC Online CMS) is the official syllabus and supersedes all versions of this document

in print.

Current version last updated July 22, 2013

By signing this statement, | agree that | have read and understand what is expected of me to perform satisfactorily in this course of study.

| also understand that any photographic and or audio recordings that are made of students including myself) during this class of are the property of
Texarkana College and can be used to promote the educational mission of Texarkana College.

Student Name (PRINT First & LAST NAME)



Legal Signature

TC Course Number / Section Number

Date



labQuest

Enzyme Action:
Testing Catalase Activity

Many organisms can decompose hydrogen peroxide (H,O») enzymatically. Enzymes are globular
proteins, responsible for most of the chemical activities of living organisms. They act as catalysts,
substances that speed up chemical reactions without being destroyed or altered during the process.
Enzymes are extremely efficient and may be used over and over again. One enzyme may catalyze
thousands of reactions every second. Both the temperature and the pH at which

enzymes function are extremely important. Most organisms have a preferred temperature range in
which they survive, and their enzymes most likely function best within that temperature range. If
the environment of the enzyme is too acidic or too basic, the enzyme may irreversibly denature,
or unravel, until it no longer has the shape necessary for proper functioning.

HzOz is toxic to most living organisms. Many organisms are capable of enzymatically destroying
the I-1z0z before it can do much damage. H, O, can be converted to oxygen and water, as follows:

2 HzOz —, 2 HzO + Oz

Although this reaction occurs spontaneously, enzymes increase the rate considerably. At least
two different enzymes are known to catalyze this reaction: catalase, found in animals and
protists, and peroxidase, found in plants. A great deal can belearned about enzymes by studying
the rates of enzyme-catalyzed reactions.

In this experiment, you will measure the rate of enzyme activity under various conditions, such as
different enzyme concentrations, pH values, and temperatures. It is possible to measure the
pressure of oxygen gas formed as H,O. is destroyed. If a plot is made, it may appear similar to
the graph shown.

At the start of the reaction, there is no product, and the pressure is the same as the atmospheric
pressure. After a short time, oxygen accumulates at a rather constant rate. The slope of the curve
at this initial time is constant and is called the initial rate. As the peroxide is destroyed, less of it
is available to react and the O, is produced at lower rates. When no more peroxide is left, O, is
no longer produced.

Figure 1
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OBJECTIVES

In this experiment you will

Use a Gas Pressure Sensor to measure the production of oxygen gas as hydrogen peroxide is
destroyed by the enzyme catalase or peroxidase at various enzyme concentrations.

Measure and compare the initial rates of reaction for this enzyme when different
concentrations of enzyme react with H,O».

Measure the production of oxygen gas as hydrogen peroxide is destroyed by the enzyme
catalase or peroxidase at various temperatures.

Measure and compare the initial rates of reaction for the enzyme at each temperature.

Measure the production of oxygen gas as hydrogen peroxide is destroyed by the enzyme
catalase or peroxidase at various pH values.

Measure and compare the initial rates of reaction for the enzyme at each pH value.

MATERIALS
LabQuest enzyme suspension
LabQuest app four 18 x 150 mm test tubes
Vernier Gas Pressure Sensor Icc
rubber-stopper assembly pH buffers
10 mL graduated cylinder test tube rack
250 mL beaker of water thermometer
3% I-1z0z four dropper pipettes
600 mL beaker Logger Pro( optional)
PROCEDURE
1. Obtain and wear goggles.
2. Connect the plastic tubing to the valve on the Gas Pressure Sensor.
3. Connect the Gas Pressure Sensor to LabQuest and choose New from the File menu. If you
have an older sensor that does not auto-ID, manually set up the sensor.
4. On the Meter screen, tap Rate. Change the data-collection rate to 0.5 samples/second and the

data-collection length to 180 seconds.

Part 1 Testing the Effect of Enzyme Concentration

5.

6.

Place four test tubes in a rack and label them 1, 2, 3, and 4.

Add 3 mL of 3.0% H,0O, and 3 mL of water to each test tube.

7. Use a clean dropper pipette to add 1 drop of enzyme suspension to test tube 1. Note: Be sure

not to let the enzyme fall against the side of the test tube.

Biology with Vernier
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Enzyme Action: Testing Catalase Activity

10.

11.

12.

13.

14.
15.

16.

Stopper the test tube and gently swirl to thoroughly mix the contents. The reaction should
begin. The next step should be completed as rapidly as possible.

rubber stopper as shown in Figure 2. Start data collection. Data

Connect the free-end of the plastic tubing to the connector in the
collection will end after 3 minutes.

Monitor the pressure readings displayed on the handheld screen. If the
pressure exceeds 130 kPa, the pressure inside the tube will be too great
and the rubber stopper is likely to pop off. Disconnect the plastic
tubing from the Gas Pressure Sensor if the pressure exceeds 130 kPa.

When data collection has finished, an auto-scaled graph of pressure vs.
time will be displayed. Disconnect the plastic tubing connector from
the rubber stopper. Remove the rubber stopper from the test tube and
discard the contents in a waste beaker.

To examine the data pairs on the displayed graph, select any data point. Figure 2
As you tap on each data point, the pressure and time values are displayed to the right of the
graph.

Determine the rate of enzyme activity for the curve of pressure vs. time. To help make
comparisons between experimental runs, choose your data points at the same time values.

a. Choose Curve Fit from the Analyze menu.

b. Select Linear for the Fit Equation. The linear-regression statistics for these two data
columns are displayed for the equation in the form

y=mx+b
c. Enter the absolute value of the slope, m, as the reaction rate in Table 2.
d. Select OK.
Store the data from the first run by tapping the File Cabinet icon.

Find the rate of enzyme activity for test tubes 2, 3 and 4:

a. Add 2 drops of the enzyme solution to test tube 2. Repeat Steps 8-14.
b. Add 3 drops of the enzyme solution to test tube 3. Repeat Steps 8-14.
c. Add 4 drops of the enzyme solution to test tube 4. Repeat Steps 8-13.

Graph all four runs of data on a single graph.

a. Tap Run 4, and select All Runs. All four runs will now be displayed on the same graph
axes.

b. Use the displayed graph and the data in Table 2 to answer the questions for Part I.

Part Il Testing the Effect of Temperature

17.
18.
19.
20.

Biology with Vernier

Place four clean test tubes in a rack and label them T 0-5, T 20-25, T 30-35, and T 50-55.
Add 3 mL of 3.0% H,O, and 3 mL of water to each test tube.

Tap Table. Choose Clear All Data from the Table menu.

Tap Graph to display the graph.
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Enzyme Action: Testing Catalase Activity

21. Measure the enzyme activity at 0-5°C.:

a. Prepare a water bath at a temperature in the range of 0-5°C by
placing ice and water in a 600 mL beaker. Using a thermometer
check that the temperature remains in this range throughout this
test. See Figure 3.

b. Place test tube T 0-5 in the cold water bath for 5 minutes so that it
reaches a temperature in the 0-5°C range. Record the actual
temperature of the test-tube contents in the blank in Table 3.

c. Add 2 drops of the enzyme solution to test tube T 0-5. Repeat
Steps 8-14.

22. Measure the enzyme activity at 30-35°C:

Figure 3

a. Prepare a water bath at a temperature in the range of 30-350c by placing warm water in a
600 mL beaker. Using a thermometer check that the temperature remains in this range
throughout this test.

b. Place test tube T 30-35 in the warm water bath for 5 minutes so that it reaches a
temperature in the 30-35°C range. Record the actual temperature of the test-tube contents
in the blank in Table 3.

c. Add 2 drops of the enzyme solution to test tube T 30-35. Repeat Steps 8-14.

23. Measure the enzyme activity at 50-550C:

a. Prepare a water bath at a temperature in the range of 50-550C by placing hot water in a
600 mL beaker (hot tap water will probably work fine). Check that the temperature
remains in this range throughout this test.

b. Place test tube T 50-55 in the warm water bath until the temperature of the mixture
reaches a temperature in the 50-55°C range. Record the actual temperature of the test-tube
contents in the blank in Table 3.

c. Add 2 drops of the enzyme solution to test tube T 50-55. Repeat Steps 8-14.

24. Measure the enzyme activity at 20-25°C (room temperature):
a. Record the temperature of test tube T 20-25 in Table 3.
b. In the tube labeled T 20-25, add 2 drops of the enzyme solution. Repeat Steps 8-13.

Part Ill Testing the Effect of pH
25. Place three clean test tubes in a rack and label them pH 4, pH 7, and pH 10.

26. Add 3 mL of 3% H,0, and 3 mL of each pH buffer to each test tube, as in Table 1.

Table 1
pH of buffer Volume of 3% Hzo2 (M) Volume of buffer (ml)
pH 4 3 3
pH 7 3 3
pH 10 3 3

27. Tap Table. Choose Clear All Data from the Table menu.
28. Tap Graph to display the graph.
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Enzyme Action: Testing Catalase Activity

29.
30.
31.

32.

In the tube labeled pH 4, add 2 drops of the enzyme solution. Repeat Steps 8-14.
In the tube labeled pH 7, add 2 drops of the enzyme solution. Repeat Steps 8-14.
In the tube labeled pH 10, add 2 drops of the enzyme solution. Repeat Steps 8-13.

Graph all three runs of data on a single graph.

a. Tap Run 3 (to the right of the graph), and select All Runs. All three runs will now be
displayed on the same graph axes.

b. Use the displayed graph and the data in Table 2 to answer the questions for Part 1.

DATA

Table 2

Rate

Label (kPa/s)

1 Drop

2 Drops

3 Drops

4 Drops

0-5°C

20-25°C

30-35°C

50-55°C

pH 4

pH 7

pH 10
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LabQuest6B

Table 3
Test tube label Rate (kPa/min)

1 Drop

2 Drops

3 Drops

4 Drops

0-SOC range: 0C
20-25°C range: 0oc

30-35°C range: 0cC
S0-SSOC range: 0cC
pH 4

pH 7

pH 10

PROCESSING THE DATA

Multiply your rate by 60 s/min to convert to kPa/min. Record the rates in Table 3.

2. For Part | of this experiment, make a graph of the rate of enzyme activity vs. enzyme
concentration on LabQuest or using Logger Pro. Plot the rate values from Table 3 on the y-
axis and the number of drops of enzyme on the x-axis.

3. For Part Il of this experiment, make a graph of the rate of enzyme activity vs. temperature.
Plot the rate values from Table 3 on they-axis and the temperature on the x-axis.

4. For Part 1l of this experiment, make a graph of the rate of enzyme activity vs. pH. Plot the
rate values from Table 3 on they-axis and the pH on the x-axis.

QUESTIONS

Part | Effect of Enzyme Concentration

1. How does changing the concentration of enzyme affect the rate of decomposition of H202?

2.

What do you think will happen to the rate of reaction if the concentration of enzyme is
increased to five drops? Predict what the rate would be for 5 drops.

Part Il Effect of Temperature

3.
4.

At what temperature is the rate of enzyme activity the highest? Lowest? Explain.

How does changing the temperature affect the rate of enzyme activity? Does this follow a
pattern you anticipated?

Why might the enzyme activity decrease at very high temperatures?

]
o
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Part 1ll Effect of pH
6. At what pH is the rate of enzyme activity the highest? Lowest?

7. How does changing the pH affect the rate of enzyme activity? Does this follow a pattern you
anticipated?

EXTENSIONS

1. Different organisms often live in very different habitats. Design a series of experiments to
investigate how different types of organisms might affect the rate of enzyme activity.
Consider testing a plant, an animal, and a protist.

2. Presumably, at higher concentrations of H,O2, there is a greater chance that an enzyme
molecule might collide with H,O.. If so, the concentration of H,O, might alter the rate of
oxygen production. Design a series of experiments to investigate how differing
concentrations of the substrate hydrogen peroxide might affect the rate of enzyme activity.

3. Design an experiment to determine the effect of boiling catalase on the reaction rate.

4. Explain how environmental factors affect the rate of enzyme-catalyzed reactions.
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Diffusion Through Membranes

Diffusion is a process that allows ions or molecules to move from where they are more
concentrated to where they are less concentrated. This process accounts for the movement of
many small molecules across a cell membrane. Diffusion allows cells to acquire food and
exchange waste products. Oxygen, for instance, might diffuse in pond water for use by fish and
other aquatic animals. When animals use oxygen, more oxygen will diffuse to replace it from the
neighboring environment. Waste products released by aquatic animals are diluted by diffusion and
dispersed throughout the pond.

It is important to consider how the rate of diffusion of particles may be affected or altered.

« Diffusion may be affected by how steep the concentration gradient is. The direction that a
diffusing molecule or ion might travel is random. While the particles are diffusing, is there a
net movement from where they are concentrated to where they are less concentrated?

« Diffusion may be affected by other different, neighboring particles. For instance, if oxygen
diffuses towards a single-celled pond organism at a certain rate, will that rate be altered by the
presence of another type of molecule? Would the presence of other molecules block or
enhance the diffusion of a molecule? Would the molecule's rate be independent of particles
that do not alter the concentration gradient?

One way to measure the rate of diffusion of ions is to monitor their concentration in solution over
a period of time. Since ions are electrically charged, water solutions containing ions will conduct
electricity. A Conductivity Probe measures the concentration of ions in a solution, but not the
concentration of electrically neutral molecules. Salts, such as sodium chloride, produce ions
when they dissolve in water. If you place a salt solution inside a selectively permeable membrane
such as dialysis tubing, the salt ions can diffuse out of the tubing and into the surrounding water.

OBJECTIVES

In this experiment, you will

» Use a Conductivity Probe to measure the ionic concentration of various solutions.

« Study the effect of temperature on diffusion.

« Study the effect of concentration gradients on the rate of diffusion.

» Determine if the diffusion rate for a molecule is affected by the presence of a second

molecule.

MATERIALS
LabQuest dialysis tubing, 2.5 em x 12 em
LabQuest App dropper pipet or Beral pipet
Vernier Conductivity Probe scissors
three 18 x 150 mm test tubes with rack stirring rod
1%, 5%, and 10% salt water 5% sucrose (table sugar) solution
400 mL beaker dental floss or clamp

ring stand and utility clamp



Figure 1

PROCEDURE

1. Set up the utility clamp, and ring stand as shown in Figure 1.

2. Set the selector switch on the side of the Conductivity Probe to the 0-2000 [!S/cm range.
Connect the Conductivity Probe to LabQuest and choose New from the File menu. If you
have an older sensor that does not auto-ID, manually set up the sensor.

3. On the Meter screen, tap Rate. Change the data-collection rate to 0.2 samples/second and the
data-collection length to 60 seconds.

Part | Concentration gradients

4. Test whether different concentration gradients affect the rate of diffusion. To do this, three
solutions of differing salt concentrations (1%, 5%, and 10%) will be placed in distilled water.
Each salt solution will be placed in a dialysis tube and allowed to diffuse into the surrounding
water. When salt diffuses, the conductivity of the water in the beaker will increase.

5. InTable 1, predict what you believe will happen in this set of experiments. How will the rate
of diffusion change when a 10% salt solution is placed in contact with pure water compared
to when a 1% salt solution is placed in contact with pure water?

6. Prepare the dialysis tubing. Obtain a wet dialysis tube and a dialysis tube clamp or a short
length of dental floss. Using the clamp or floss, tie one end of the tube closed about 1 em
from the end, as in Figure 2.



10.

11.

12.

13.

14.

15.

16.

17.

Place a 1% salt solution into a section of dialysis tubing. To do this,

a. Obtain about 15 mL of a 1% salt water solution in a test tube.

b. Using a funnel or Beral pipet, transfer about 10 mL of the 1%
salt water into the dialysis tube, as in Figure 2. Note: To open
the tube, you may need to rub the tubing between your fingers.

c. Tie off the top of the dialysis tube with a clamp or a new length
of dental floss. Try not to allow any air into the dialysis tube.
The tube should be very firm after it is tied or clamped. Trim off
any excess dental floss extending more than 1em from either
knot.

d. Wash the outside of the tubing with tap water thoroughly, so that
there is no salt water adhering to the tubing. Figure 2

Place 300 mL of distilled or deionized water into a 400 mL beaker. Secure the Conductivity
Probe with the utility clamp in the water filled beaker as shown in Figure 1.

Place the dialysis tube into the water. Be sure the tubing is submerged completely under the
water. Important: Position the Conductivity Probe and dialysis tubing the same distance
apart in each trial.

After stirring the solution for 15 seconds, start data collection. Stir the solution slowly and
continuously throughout the one-minute data collection period.

Data collection will stop after 60 seconds. Analyze the graph to determine the rate of
diffusion for the curve of conductivity vs. time:

a. Examine the graph and identify the most linear region.

b. Tap and drag your stylus across the most linear region to P
select these data points. /

c. Choose Curve Fit from the Analyze menu. Select Linear e I
as the Fit Equation. A

d. Record the slope, m, as the rate of diffusion in (ftS/cm/s)

in Table 2. Select OK.

Remove one of the clamps. If the dialysis tubing is tied off with floss, use a pair of scissors
and carefully cut one of the dental floss knots and discard the floss. If you accidentally make
a cut in the tubing, replace it.

Empty all of the liquid out of the dialysis tube. Squeeze the excess liquid out with your
fingers.

Rinse the Conductivity Probe with distilled water.
Store the data from the first run by tapping the File Cabinet icon.

Obtain 15 mL of a 5% salt solution in a test tube. Repeat Steps 7-15, substituting this 5% salt
solution for the 1% solution.

Obtain 15 mL of a 10% salt solution in a test tube. Repeat Steps 7-15, substituting this 10%
salt solution for the 1% solution.



18. Graph all three runs of conductivity data on a single graph.

a. Tap Run 3 and select All Runs. All three runs will now be displayed on the same graph.
b. Examine the graph closely and make a conclusion. Record your conclusion in Table 1.

19. (Optional) Transfer your data to a computer for later printing per your teacher's instructions.

Part Il Effect of other molecules

In this set of experiments you will measure the rate of diffusion of salt while it is in the presence of
a non-conducting molecule. Since sugar does not form ions in solution, it should not conduct
electricity. Therefore, sugar will be added to the water to determine whether it interferes with the
diffusion of salt.

20. In Table 1, predict what you believe will happen in this set of experiments. Will the non-
conducting sugar in the water block or reduce the rate of diffusion of salt? Explain your
prediction.

Test to determine if water or a sugar solution conducts electricity.
21. Place about 100 mL of distilled or deionized water in a clean 400 mL beaker.

22. Test the conductivity of the water by placing a clean Conductivity Probe into it.
23. Tap Meter. Record the conductivity value in Table 3.
24. Obtain 300 mL of a 5% sugar solution in a clean 400 mL beaker.

25. Test the conductivity of the 5% sugar solution by placing a clean Conductivity Probe into it.
Record the conductivity value in Table 3.

Test if 5% sugar interferes with the diffusion of a 5% salt solution.
26. Repeat Steps 6-14, with the following changes:
a. Substitute a 5% salt solution for the 1% solution in Step 7.

b. Use 300 mL of 5% sugar water in place of the water in Step 8.
c. Record the slope, m, as the rate of diffusion in (fIS/cm/s) in Table 4.



DATA

Table 1

Prediction

Part |

Part Il

Part |
Table 2: Summary of Data
Salt concentration Rate of diffusion
(%) (tS/lcm/s)
1
5
10
Part 11
Table 3 Table 4: Summary of Data
Solution Conductivity Solution Rate of diffusion
(tS/cm) (tS/emls)
Distilled water 5% salt
Sugar water 5% salt/ 5% sugar

QUESTIONS

1. What conclusion can you draw from the data in Table 2?

2. How did your conclusion compare to your prediction for Part 1? Can you account for any
differences?

3. If the rates in any of the three experiments varied in Part I, calculate how much faster each
rate was compared to that for the 1% salt solution. For instance, if the rate of the 1% solution
was 1 tS/cm/sand the rate of the 10% solution was 5 S/cm/s, then the rate of diffusion for
the 10% solution would be (5/1) five times the rate of the 1% salt solution.

4. Compare the conductivity of pure water with asugar solution. How do you account for this?

5. What conclusion can you draw from the data in Tables 3 and 4?
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EXTENSIONS

1. Make a plot of the rate of diffusion vs. the salt concentration. Using your plot,
estimate the rate of diffusion of a 3% salt solution.

2. If the results of the experiments in Part | can be extrapolated to diffusion in living
systems, how would a single-celled organism respond in an oxygen rich pond
compared to an oxygen-poor pond? Explain.

3. Design an experiment to determine the effect of temperature on the diffusion of salt.
Perform the experiment you designed.

4. Ectotherms are organisms whose body temperatures vary with the surrounding
environment.
On the basis of your data from Extension Question 3, how do you expect
the oxygen consumption of ectotherms to vary as the temperature varies?
Explain.

5. If waste products of an aquatic single-celled organism were released into a pond,
how would that affect the organism's ability to obtain oxygen from the pond water?
Explain how your data from Part 1l supports your answer.



Student Learning Outcomes (SLO)
BIOL 1306

1. Describe the characteristics of life.

2. Explain the reasoning used by scientists.

3. Identify the basic properties of substances needed for life.

4. Compare and contrast the structures, reproduction, and characteristics of viruses, prokaryotic cells
and eukaryotic cells.

5. Describe the structures of cell membranes and the movement of molecules across a membrane.

6. Identify the substrates, products, and important chemical pathways in metabolism.

7. Identify the principles of inheritance and solve classical genetic problems.

8. Identify the chemical structures, synthesis, and regulation of nucleic acids and proteins.

9. Describe the unity and diversity of life and the evidence for evolution through natural selection.




